Appendix C
ChemiDoc EQ

Fig.C-1. ChemiDoc EQ.

Before you can begin acquiring images, the ChemiDoc EQ system must be properly
installed and connected with the host computer. See the ChemiDoc EQ hardware
manual for installation, startup, and operating instructions.
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To use the ChemiDoc EQ, you will need to have the Bio-Rad-supplied acquisition
board installed in your PC or Macintosh. The drivers for this board will be installed
when you install the main software application.

Make sure that your ChemiDoc EQ camera is turned on. If the camera is not turned
on, the ChemiDoc EQ acquisition window will open and an image capture error will
be displayed.

Simulation Mode

Any of the imaging device acquisition windows can be opened in “simulation mode.”
In this mode, an acquisition window will open and the controls will appear active, but
instead of capturing real images, the window will create “dummy” images of
manufactured data.

You do not need to be connected to an imaging device to open a simulated acquisition
window. This is useful for demonstration purposes or practice scans.

To enter simulation mode, hold down the CTRL key and select the name of the device
from the File menu. The title of the acquisition window will indicate that it is
simulated.

C.1 ChemiDoc EQ Acquisition Window

To acquire images using the ChemiDoc EQ, go to the File menu and select ChemiDoc
EQ.... The acquisition window for the instrument will open, displaying a control
panel and a video display window.
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Fig.C-2. ChemiDoc EQ acquisition window

The ChemiDoc EQ video display window will open in “live” mode, giving you a live
video display of your sample. If no image is visible, make sure the camera is on,
check the cable connections, make sure the iris on the camera is not closed, and make
sure that the protective cap is off the camera lens. Also check to see that the
transilluminator is on and working.

The control panel has been arranged from top to bottom to guide you through the
acquisition procedure. There are six basic steps to acquiring an image using the
ChemiDoc EQ:

1. Position and focus the gel or other object to be imaged.
2. Select Mode.

3. Acquire the image.
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4. Optimize the display.
5. Analysis.

6. Select the output.

C.2 Step Il. Position Gel

The ChemiDoc EQ window will open in “live” mode, giving you a live video display
of your sample. In this mode, the Live/Focus button will appear selected, and frames
will be captured and displayed at about 10 frames per second, depending on the speed
of your computer.

You can use live mode to zoom, focus, and adjust the aperture on the camera, while
positioning the sample within the area.

Note:  Newer versions of the ChemiDoc EQ feature a motorized zoom lens that can be
controlled directly from the acquisition window using the Iris, Zoom, and Focus
arrow buttons. Click on the Up/Down buttons while viewing your sample in the
window to adjust the lens. These buttons will not be visible if you are connected
to older versions of the ChemiDoc EQ without the motorized zoom lens.
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Fig.C-3. Live/Focus button and camera control buttons.

You can also select the Show Alignment Grid checkbox to facilitate positioning.

Note:  After positioning your sample, you should check the Imaging Area dimensions
under Options (see section C.9, Options) to make sure that they conform to the
size of the area you are focusing on. To determine the size of the area you are



Appendix C. ChemiDoc

focusing on, you can place a ruler in the ChemiDoc EQ cabinet so that it is
visible in the image.

C.3 Step Il. Image Mode

The Image Mode option buttons change the type and scale of the data, as well as the
behavior of the ChemiDoc EQ when acquiring an image.

uv

Select this mode for fluorescent samples. With this mode selected, the data will be
measured in linear intensity units.

White Light

Select this mode for reflective and transmissive samples. With this mode selected, the
data will be measured in uncalibrated optical density (uOD) units.

Chemi

This mode is designed for chemiluminescent samples. With this mode selected, the
data is measured in linear intensity units; however, the data is inverted, so that
samples will appear dark on a light background.

Also, Chemi mode changes the behavior of the Auto and Manual Expose functions, as
described above.

C.4 Step Ill. Acquire Image

For many white light applications, you can skip this step and save and print images
directly from Live/Focus mode.

For UV light, chemiluminescent applications, or faint samples, the ChemiDoc EQ
control panel has several features for creating image exposures. You can take an
automatic exposure based on the number of saturated pixels in the image, you can
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enter a specific exposure time, or you can take a series of exposures and select the
best one.

Note:  “Exposure” refers to the integration of the image on the camera CCD over a
period of time. The effect is analogous to exposing photographic film to light
over a period of time.

Auto Expose

Use Auto Expose if you want to take a single exposure but are uncertain of the
optimal exposure time.

Note:  If you know the approximate exposure time you want (+ 3 seconds), you can skip
this step and go directly to Manual Expose.

Click on the Auto Expose button to cancel Live/Focus mode and begin an automatic
exposure. The Auto Expose button will appear selected throughout the exposure.

During the auto exposure, the image is continuously integrated on the camera CCD
until it reaches a certain percentage of saturated pixels. This percentage is set in the
Options dialog box. (Default = 0.15 percent. See section C.9, Options.)
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Fig.C-4. Selecting Auto Expose.

Once an image has reached the specified percentage of saturated pixels, it is captured
and displayed in the video display window, Auto Expose is automatically deactivated,
and the exposure time appears active in the Exposure Time field.
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At this point, if you are in UV or White image mode, Manual Expose will be
automatically activated. If you are in Chemi mode, the Freeze button will be
automatically activated.

Note:  If you are having difficulty auto-exposing your sample, you can use Manual
Expose to adjust your exposure time directly. Most non-chemi applications only
require an exposure time of a few seconds, which can be quickly adjusted using
Manual Expose.

Manual Expose

If you know the approximate exposure time you want, you can click on the Manual
Expose button. In UV or White image mode, Manual Expose is automatically
activated after Auto Expose is complete.
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Fig.C-5. Setting a manual exposure.

With Manual Expose activated, you can adjust the exposure time directly by changing
the number of seconds in the Exposure Time field. Type in a number or use the arrow
buttons next to the field.

In UV or White image mode, when the specified exposure time is reached, the last

captured image will be displayed in the ChemiDoc EQ image window. The camera
will continue to integrate the image on the CCD, updating the display whenever the
specified number of seconds is reached.
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Once you are satisfied with the quality of the displayed image, click on the Freeze
button to stop the exposure process. The last full exposure will be displayed in the
image window.
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Fig.C-6. Freezing the manual exposure.

In Chemi mode, Manual Expose will expose an image over the specified exposure
time and then stop automatically.

Note:  Freeze is automatically activated if you adjust any of the subsequent controls
(e.g., Video Print, Image Mode, Display controls, etc.).
Live Acquire

Live Acquire mode allows you to specify an interval over which a series of
progressively longer exposures are taken. All exposures are then displayed on the
screen, and you can choose the one with the best image.

Click on the Live Acquire button. A settings dialog box will open in which you can
specify the total exposure time, starting exposure time, and number of exposures.
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Fig.C-7. Live Acquire settings.

Note:  You should specify no more than 10 exposures in the Live Acquire Settings
dialog, to avoid excessive build-up of image background in later exposures. The
fewer the exposures, the less background will be added to the image. See the
Release Notes for additional instructions on reducing background in images
captured using Live Acquire.

Select the Save Images checkbox if you want to automatically save each exposure as
it is taken.

Click on OK in the settings dialog to begin taking exposures. If you selected Save
Images, a Save dialog box will open in which you can specify the base file name and
location of the exposure files. When you click on Save, the exposures will be taken.

The specified number of exposures will be taken at equal intervals between the
starting exposure time and total exposure time. When each exposure is complete, an
image window containing that exposure will open behind the ChemiDoc EQ window.
When the full exposure time has lapsed, all the image windows will move in front of
the ChemiDoc EQ window.

Note that the first exposure will have the base file name (the default base file name is
the computer user name and a time stamp). Each subsequent exposure will have a
version number (v2, v3, v4, etc.) appended to the base file name. The highest version
number will be the final exposure. If you did not elect to auto-save the exposures as
they were created, then each image will be unsaved.
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To stop the Live Acquire, click on the Freeze button or adjust any of the subsequent
controls (e.g., Video Print, Image Mode, Display controls, etc.).

Note:  Exposures captured before freezing will be displayed in image windows.

Study the different images and select the best exposure(s) to keep. You can then
proceed to the next step.

C.5 Step IV. Optimize Display

The Display controls are useful for quickly adjusting the appearance of your image
for output to a video printer. Adjusting these controls will automatically freeze the
video display and allow you to alter the image within the ChemiDoc EQ window.
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Fig.C-8. Display controls.

These controls are similar to those in the Transform dialog box.

Note:  The Display controls will only change the appearance of the image. They will not
change the underlying data.

High/Low Sliders

If Auto-scale doesn’t give you the appearance you want, you can use the High and
Low sliders to redraw the image yourself. In white light mode and chemi mode,
dragging the High slider handle to the left will make weak signals appear darker. In
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UV mode, dragging the High slider handle to the left will make weak signals appear
brighter. Dragging the Low slider handle to the right will reduce background noise.

You can also type specific High and Low values in the text boxes next to the sliders.
Clicking anywhere on the slider bars will move the sliders incrementally.
Gamma Slider

Some images may be more effectively visualized if their data are mapped to the
computer screen in a nonlinear fashion. Adjusting the Gamma slider handle changes
the light and dark contrast nonlinearly.

Highlight Saturated Pixels

When this box is checked, any saturated pixels in the image will appear highlighted in
red in the scan window and in the pop-up image window. To view/hide saturated
pixels in the pop-up image window, use the Image > Transform command.

Invert Display

This checkbox will switch light spots on a dark background to dark spots on a light
background, and visa versa. This will only affect how the image is displayed on the
screen, not the actual image data.

Auto-scale

Clicking on Auto-scale will adjust your displayed image automatically. The lightest
part of the image will be set to the minimum intensity (e.g., white), and the darkest
will be set to the maximum intensity (e.g., black). You can then “fine tune” the
display using the High, Low, and Gamma sliders described below.

Reset

Reset will return the image to its original, unmodified appearance.
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C.6 Step V. Analysis

The Analysis step of the ChemiDoc EQ acquisition window allows you to add
annotations and analyze the newly acquired image.
Annotate

Clicking on Annotate will open a separate image window displaying the captured
image. The default name for the image will include the date, time, and user (if
known).

The Text Overlay toolbar will also pop up to allow you to annotate your image.

The image will not be saved until you select Save or Save As from the File menu.

Analyze

Clicking on Analyze will open a separate image window displaying the captured
image. The default name for the image will include the date, time, and user (if
known).

You can then analyze the image using the other features in the main application.

The image will not be saved until you select Save or Save As from the File menu.

C.7 Step VI. Select Output

The ChemiDoc EQ window has several output options.

~Step V1. Select Output

= \ideo Print

[ Save

Fig.C-9. Output options.
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Video Print

Clicking on Video Print will automatically send the currently displayed frame (either
live or integrated) to a video printer. You can add information about your image to the
bottom of the printout by selecting the appropriate checkboxes in the Options dialog
box. (See section C.9, Options.)

Save

Clicking on Save will open a separate image window displaying the captured image.
A Save As dialog box will automatically open displaying the default file name for the
image, which will include the date, time, and user (if known). You can then change
the file name and storage directory.

You can also export your image as a TIFF image for viewing with other applications.

C.8 Exposure Status

The Exposure Status bar shows the progress of your exposure. If your exposure time
is greater than 1 second, the status bar display will give you a graphical representation
of the remaining time before exposure is complete.

If the exposure time is less than 1 second, the status bar will not refresh itself for each
exposure; it will remain at 100 percent.

C.9 Options

Click on the Options button to open the Options dialog box. Here you can specify
certain settings for your ChemiDoc EQ system.
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Fig.C-10. Available options in the ChemiDoc EQ acquisition window.

Click on OK to implement any changes you make in this box. Clicking on Defaults
restores the settings to the factory defaults.

DAC Settings

Note:  The default DAC settings are highly recommended and should be changed with
caution.
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These sliders may be used to adjust the minimum and maximum voltage settings of
your video capture board. The minimum slider defines the pixel value that will appear
as white in the image, while the maximum slider defines the pixel value that will
appear as black. The slider scale is 0-255, with the defaults set to 60 minimum and

130 maximum.

Imaging Area

These fields are used to specify the size of your imaging area in centimeters, which in
turns determines the size of the pixels in your image (i.e., resolution). When you
adjust one imaging area dimension, the other dimension will change to maintain the

aspect ratio of the camera lens.

Note:  Your imaging area settings must be correct if you want to do 1:1 printing. These
are also important if you are comparing the size of objects (e.g., using the
Volume Tools) between images.

Auto Exposure Threshold

When you click on Auto Expose, the exposure time is determined by the percentage
of saturated pixels you want in your image. This field allows you to specify that

percentage.

Typically, you will want less than 1 percent of the pixels in your image saturated.
Consequently, the default value for this field is 0.15 percent.

Reminder

When this checkbox is selected, the software will warn you to turn off your
transilluminator light when you exit the ChemiDoc EQ acquisition window or when
your system is “idle” for more than 5 minutes.

Note:  If you are performing experiments that are longer than 5 minutes (e.g.,
chemiluminescence), this should be deselected.
Video Printing Footer Information

The checkboxes in this group allow you to specify the information that will appear at
the bottom of your video printer printouts.
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Save Options

To automatically create a backup copy of any scan you create, select the Make
Backup Copy checkbox.

With this checkbox selected, when you save a scan, a backup copy will be placed in
the same directory as the scanned image. Backup images are identified by "Backup
of" followed by the original image file name.

Note:  Backup files are read only files. If you attempt to save a backup file, you will be
promted to give it a new name. This protects the backup file and preserves it from
any changes.

Simple Acquisition Mode

The Simple Acquisition mode option allows you to reconfigure the ChemiDoc EQ
acquisition window to simple mode. In simple mode, the acquisition window contains
the same steps as the advanced acquisition window with the exception of Step IV,
Optimize display, and Step V, Analysis. Manual exposure is also disabled in simple
mode.
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Fig.C-11. Simple Acquisition Window

To change the acquisition window to Simple Acquisition Mode, check the box
marked Simple Acquisition Mode. The change will take effect the next time you open
the acquistion window.
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